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Access to Applicant “Sandbox” 

1. Access your user login information via Submittable and navigate to the link provided to directly access the group 

or use the following link to navigate to your group:nm-community.maps.arcgis.com 

2. Sign in. 

 

  
 

3. Upon signing in, a screen asking for email verification will appear. Click “Send verification email” to receive an 

email to verify your email. Use the provided code to verify your email. Once this is complete, your email will be 

verified, and you can proceed to the mapping tool. 

 
 

4. Navigate to the “Groups” tab on the top ribbon of the page.  

 

mailto:OBAE-gis@doit.nm.gov
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5. Click on your OBAE BEAD group to see the available data and mapping app. 

 

1. Hover over the Featured Content “BEAD Proposal Map” and click “View details” on the “Overview” page or 

navigate to the “Web Mapping Application” in the “Content” tab of the group.  

2. Click “View” to open the mapping tool. 

 

 

Reminders & Best Practices 

• The app is built on two datasets, the 100% and Alt% Unserved feature layers. When using the edit tools, it is 

critical to toggle on the appropriate layer for editing. The layers will display as shown below: 

 

 
100% 

 

 
Alt% 

 

• BEAD Eligible BSLs will symbolize by technology as the user edits, as shown in the legend. 

• If working with more than 3,200 BSLs, the user will need to export in batches less than 3,200 records. 

• Filtering by the map extent will reduce the number of records in the table and in exports. 

• If there is more than one user in the applicant group, keep in mind that both users can edit each other’s work. 

mailto:OBAE-gis@doit.nm.gov
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• Some tools are optional and not required to complete the application, but they have been included in the 

mapping tool to aid in the application process. 

• The data attribute tables are sorted numerically by PAU ID, but the tables can be sorted by any of the column 

headings. 

• Contact OBAE-gis@doit.nm.gov for assistance. 

 

Quick Start-Up Guide 

This section is a bare-bones guide to expedite the use of the BEAD mapping tool. Follow this section of the guide for 

more detailed information on the mapping tool. 

Navigate to the shared BEAD group and open the mapping app.  

 

Click on the “more” button.  The most important tools for BEAD funding application are listed below. 

 

 

Filtering to your PAU of interest narrows down the amount of BEAD eligible (unserved) BSLs to a particular PAU. This tool 

is not necessary, specifically if user is planning by network design instead of by PAU. If the user is planning to propose 

service to 100% of the eligible BSLs in one PAU, filter using the 100% dataset. If the user is unable to service all the 

eligible BSLs in one PAU, please filter using the Alt% dataset.  

To use the filter, simply select the PAU in the drop-down menu and toggle the tool on   

to filter the chosen dataset. The tool zooms to the filtered selection on the map and will  

display in the bottom left of the attribute table. 100% BSLs will default to “In Project,”  

while Alt% BSLs will default to “Not In Project” This filter will remain for the entirety of  

the planning process unless it is removed.  

 

 

If serving 100% of BEAD Eligible BSLs within a PAU, batch edit all the BSLs using this tool.  

Eligible BSLs will not show 

up in the filter unless 

toggled on in the layer list. 

  

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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1. Toggle on the 100% layer in the focused map layers. 

 

 
2. Make sure the correct attribute table is displaying (100% unserved BSLs) 

3. Choose a selection option. The polygon selection option requires a click to begin the selection. 

 
4. Select your BEAD Eligible BSLs.  

5. Fill out the fields for the selected BSLs. 

 
6. Click save (data should be updated in the attribute table and in the map) 

7. Click "refresh" in the attribute table to see edited data.  

8. Check the focused legend that all the BSLs are solid filled, and the technology is correct. 

 

 

 

If you choose NOT to serve 100% of BEAD Eligible BSLs within a PAU, you can batch edit an alternative amount of BSLs 

using this tool. This tool is the same as the Edit 100% tool, but all the eligible BSLs are not assumed to be “In Project.” To 

add the BSLs to the project, select “Yes” in the “In Project?” field. Please see the section above (100% Edit) for batch edit 

instructions. 

 

The selection will be in 

the attribute table below. 

View only the selected 

records by locating the 

“Options” button and 

selecting “Show selected 

records.” Clicking on a 

feature will zoom to the 

feature on the map. 

 

*TIP* 

Avoid losing the edit tool 

by not clicking out of the 

pop-up before saving the 

data. Data can be re-

edited at any time. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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When all editing is complete, export the data to csv by navigating to  

the desired dataset in the attribute table and click on “Export all to  

CSV” in the “Options” menu.   

 

 

Full Mapping App Guide: 

The map will open to display Project Area Units (PAU), FCC Official BEAD Deduplicated broadband service locations 

(BSLs), and attribute tables of both the 100% and Alternative% unserved BSL layers. 

 

 

The map tools in the map (above) allow the user to zoom in and out on the map, return to the original map extent, 

pinpoint the user’s location, search an address or area of interest, view a focused legend, view and toggle data layers for 

the legend, and bookmark areas of interest in the app. 

The map tools in the left panel are described below.  

  

   

Clicking the information button will provide instructions on app use and other important information 

 

Clicking the basemap button will allow the user to choose between any basemap available. 

 

Clicking the legend button will show layer symbology for layers in the map.  

It’s possible to export a 

single PAUs worth of data 

or a filtered extent. Using 

the 

button on the attribute 

table will reduce the 

number of records in the 

exported csv. 

*TIP* 

Some layers will not be 

shown because they are 

contextual and non-

editable. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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Clicking the layer list button will allow the user to toggle layers available in the map. Some layers, such as “V5 

Provider Service Availability Hex8,” “Tribal Land,” “Counties,” state and federal grants, and “FCC Official BSL BDC 

Service BEAD Deduplicated” are contextual layers to use as a guide when assembling data for an application. 

 

This (more) button takes the user to the proposal planning portion of the app. 

 

Proposal Planning Tools: 

 

 
 

 

This tool (can be SLOW to respond) allows the user to print a map extent. Select “Advanced” for extent, legend, and 

author naming options. There is a field for “map author” that is editable. 

 

 

This tool allows the user to add data from ArcGIS Online, by URL, and by file. Once data are added, they will display at the 

bottom of the panel.  Once added, the layer can be toggled on-off in the map, using the layers tool.  

 

 

 

The forward and the back 

buttons on the lower right 

portion of the tool panel 

will maximize and 

minimize the tool panel. 

 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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This tool allows the user to query provider service claims across the state. On the “Tasks” tab, search by brand name and 

technology. The result layer name can be edited as desired. After the query is applied, the results tab will show all the 

relevant results that can be zoomed to by clicking on your result of choice.  

The options button displays the results in the attribute table and remove the result. To collapse the features, click on 

the “Collapse All” button Choose the options button to view these features in the attribute table. 

*TIP* Only one query can be run at a time (query results are not stored, so a new query replaces the existing one). Query 

results will remain in the map until they are removed, either by turning off the layer in the layer list, or removing from 

the  options. 

 

 

 

Click on the  button 

to return to the list of 

tools.  

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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Filtering to your PAU of interest narrows down the amount of BEAD eligible (unserved) BSLs to a particular PAU. This tool 

is not required to plan proposals. There are two datasets to filter on, the 100% and the Alternative% (Alt%). If the user is 

planning to propose service to 100% of the eligible BSLs in one PAU, filter using the 100% dataset. If the user is unable to 

service all the eligible BSLs in one PAU, please filter using the Alt% dataset.  

To use the filter, simply select the PAU in the drop-down menu and toggle the tool on  to  

filter the chosen dataset. The tool zooms to the filtered selection on the map and will display  

in the bottom left of the attribute table. 100% BSLs will default to “In Project,” while Alt% BSLs  

will default to “Not In Project” This filter will remain for the entirety of the planning  

process unless it is removed. 

 

 
Use the next 5 tools to identify the BSLs in the project area. 

 

If serving 100% of BEAD Eligible BSLs within a PAU, batch edit all the BSLs using this tool.  

 

1. Toggle on the 100% layer in the focused map layers. 

 
2. Make sure the correct attribute table is displaying (100% unserved BSLs) 

3. Choose selection option (the polygon selection tool requires a click to begin the selection).  

4. Select your BEAD Eligible BSLs.  

5. Fill out the fields for the selected BSLs (number of records should be displayed in the attribute table)  

(preserve the filled-out data by avoiding clicking out of the edit widget)

 
6. Click save (data should be updated in the attribute table and in the map) 

 

Eligible BSLs will not show 

up in the filter unless 

toggled on in the layer 

list. 

 

*TIP* 

Avoid losing the edit tool 

by not clicking out of the 

pop-up before saving the 

data. Data can be re-

edited at any time. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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7. Click "refresh" in the attribute table to see edited data.  

8. Check the focused legend that all the BSLs are solid filled, and the technology is correct. 

 

 

 

To check progress during the proposal process, use this chart to check the percentage of BSL points that have been 

edited, as well as the technologies that have been assigned to them. Hover over the bars in the graph to highlight the 

BSLs referenced in the chart. 

 
 

 

If you choose NOT to serve 100% of BEAD Eligible BSLs within a PAU, you can batch edit an alternative amount of BSLs 

using this tool. This tool is the same as the Edit 100% tool, but all the eligible BSLs are not assumed to be “In Project.” To 

add the BSLs to the project, select “Yes” in the “In Project?” field. Please see the “Edit 100% (multiple BSLs)” tool for 

instructions. 

 
 

The selection will be in 

the attribute table below. 

View only the selected 

records by locating the 

“Options” button and 

selecting “Show selected 

records.” Clicking on a 

feature will zoom to the 

feature on the map. 

 

*TIP* 

Keep in mind that this 

chart will show any 

previously filtered 

selection if it wasn’t 

previously removed. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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This chart allows the user to check progress and is the same as the “100% Chart (unserved, as  

filtered)” above. Use this chart to check the percentage of BSL points that have been edited,  

as well as the technologies that have been assigned to them. 

 

 

Access this chart to view the count and percentage of BSLs in the Alt% proposal. The button allows the user to add a 

legend or data labels to the chart. 

  
 

 

 

This tool searches for any missing values that have not been defined. On the “Tasks” tab, choose either the 100% or Alt% 

dataset. The results will show all the BSLs that have missing values. Each BSL feature will be expanded by default. To 

collapse the features, click on the “Collapse All” button Choose the options button to view these features in 

the attribute table. 

After the query is applied, the results can be zoomed to by clicking on the result. The options button allows the user to 

view the results in the attribute table and remove the result. The “filter by map extent” may not reduce the number of 

records for this tool. 

 

 

Any missing value can be edited point by point with this tool. Simply click on the BSL missing edits and fill in the missing 

values. Once saved, the edited BSL will visually change to display the technology it’s been designated.  

 
 

 

Just like in the previous 

chart, keep in mind that 

this chart will show any 

previous filtered selection 

if it wasn’t previously 

removed. 

*TIP* 

Keep in mind that this 

chart will show any 

previous filtered selection 

if it wasn’t previously 

removed. 

*TIP* 

Make sure the dataset is 

editable by toggling it on 

and that there are no 

filters on that may hide 

eligible BSLs. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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This tool allows the user to create an area of interest (AOI) summary report based on a buffer. In the “Place name” tab, 

search for an address or area of interest and create a buffer by adding a measured distance around the AOI and clicking 

“Report.” The report will show how many eligible BSLs in both the 100% and the Alt% datasets, as well as the counts for 

both unserved and served BEAD eligible points and CAIs. Expanding the report will highlight individual features, and 

clicking features will highlight the feature on the map. The options above the features on the right allow the user to 

refresh the report, download to csv, print, or change the metrics of the report.  

The “Draw” tab will act similarly, with the difference being instead of searching for an AOI, draw the AOI on the map 

using one of the drawing shapes or choosing to use one of the layers in the app. Choosing the select option will allow the 

user to select a PAU to summarize within. 

 

 

 

When all editing is complete, export the data to csv by navigating to the desired dataset in the attribute table and click 

on “Export all to CSV” in the “Options” menu.  

  

 

 

 

  

Make sure the dataset is 

editable by toggling it on 

and that there are no 

unwanted filters on that 

may hide eligible BSLs. 

*TIP* 

It’s possible to export a 

single PAUs worth of data 

or a filtered extent. Using 

the 

button on the attribute 

table will reduce the 

number of records in the 

exported csv. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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Access to Exportable Data 

1. If seeking to export the data used for the application, navigate to the “Content” tab within the BEAD group. 

2. Navigate and click on to the feature layer in the group. 

 

3. Click the “Export Data” drop-down button to choose the data format for export. 

 

  

mailto:OBAE-gis@doit.nm.gov
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4. Once a format is chosen, a pop-up will appear to change the title, add tags, and enter a description, if desired.

 
 

5. Click Export. Note that the data layers are large and may take more than a minute to export. The data will appear 

in the user’s content in the chosen format. 

 

6. Download the data using the “Download” button. 

  

mailto:OBAE-gis@doit.nm.gov
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Data Use Key: 

 

BEAD_Status 

Code Description 

0 Unserved (BEAD-Eligible) 

1 Underserved (Not BEAD-Eligible) 

2 Served (Not BEAD-Eligible) 

 

ProposedTech_100Pct // ProposedTech_AltPct 

Code Description 

50 Fiber (50) 

40 Cable (40) 

71 LFW (71) 

72 LBR (72) 

10 DSL (10) 

 

CAI_Flag 

Code Description 

0 FALSE 

1 TRUE 

 

InProject_100Pct // InProject_AltPct 

Code Description 

0 No 

1 Yes 

 

ProjectType 

Code Description 

1 100% 

9 Alt% 

 

 

mailto:OBAE-gis@doit.nm.gov
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Broadband Ownership Tool: 

The NM Broadband Ownership Tool is intended to assist BEAD Applicants in proposal planning. A user may either upload 

their own route or link their own ArcGIS Feature Service to return the percentage distribution of BLM land within a user-

defined distance around the selected route. The following is a guide for using this tool. 

• Use the link or navigate within your group to access the tool called “NM Broadband Ownership.” The user will 

get a prompt to log in to view this tool. The login is the same login as the BEAD mapping tool. 

https://experience.arcgis.com/experience/db8f4c01a1e74472ada1327a1882983d 

• Once the tool opens, there is an option to add data by URL, file, or by searching by group, organization, ArcGIS 

Online, or Living Atlas. 

 

   
 

• Alternately, you can use basic tools to draw a line, input a buffer distance that will estimate total area within the 

buffer you have drawn. 

Use the  button to create the summary using a map layer. 

 

 

 

 

 

 

• Use the button to draw a point, line, polygon, or circle to draw an area to  

summarize around or within.  

If uploading a large 

dataset, the ownership 

tool may not work. If 

uploading a shapefile, the 

data will need to be in a 

zip file. 

*TIP* 

The and 

buttons require a double-

click to finish the drawing, 

while the rest of the draw 

options use a drag and 

drop draw function. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov
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• Once the data is added or the area of interest is drawn, input the buffer distance and choose a unit before 

clicking the “Run” button. 

 

• Summaries will reside in the “History” tab. Clicking on the summary will show the result and parameters of the 

summary. Click the button to see statistics on the summary or export to JSON, CSV, or Item. 

 
 

 

The summary may take a 

while to run and render. 

*TIP* 

mailto:OBAE-gis@doit.nm.gov

